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A Safety Information

Persons supervising and performing the electrical installation or
maintenance of a Drive and/or an external Option Unit must be suitably
qualified and competent in these duties. They should be given the
opportunity to study and if necessary to discuss this User Guide before
work is started.

The voltages present in the Drive and external Option Units are capable of
inflicting a severe electric shock and may be lethal. The Stop function of
the Drive does not remove dangerous voltages from the terminals of the
Drive and external Option Unit. Mains supplies should be removed before
any servicing work is performed.

The installation instructions should be adhered to. Any questions or doubt
should be referred to the supplier of the equipment. It is the responsibility
of the owner or user to ensure that the installation of the Drive and
external Option Unit, and the way in which they are operated and
maintained complies with the requirements of the Health and Safety at
Work Act in the United Kingdom and applicable legislation and regulations
and codes of practice in the UK or elsewhere.

The Drive software may incorporate an optional Auto-start facility. In
order to prevent the risk of injury to personnel working on or near the
motor or its driven equipment and to prevent potential damage to
equipment, users and operators, all necessary precautions must be taken if
operating the Drive in this mode.

The Stop and Start inputs of the Drive should not be relied upon to ensure
safety of personnel. If a safety hazard could exist from unexpected
starting of the Drive, an interlock should be installed to prevent the motor
being inadvertently started.



General information

The manufacturer accepts no liability for any consequences resulting from
inappropriate, negligent or incorrect installation or adjustment of the
optional operating parameters of the equipment or from mismatching the
variable speed drive (Drive) with the motor.

The contents of this User Guide are believed to be correct at the time of
printing. In the interests of a commitment to a policy of continuous
development and improvement, the manufacturer reserves the right to
change the specification of the product or its performance, or the
contents of the User Guide, without notice.

All rights reserved. No parts of this User Guide may be reproduced or
transmitted in any form or by any means, electrical or mechanical including
photocopying, recording or by any information-storage or retrieval system,
without permission in writing from the publisher.

Copyright © November 1997 Control Techniques Drives Ltd
Author: CT SSPD

Originators ~ AH, PB
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Introduction

11

On a Variable Speed Drive (such as Mentor I, Vector or CDE), timing
functions necessary for the correct operation of power devices are
performed by its own microprocessor operating in real-time. This imposes
limitations on the microprocessor when carrying out other duties, resulting
in areduction of flexibility of the Drive.

To maximize this flexibility, a second processor can be used for running
application-specific software. This second microprocessor is the MD29
which allows the Drive to be easily adapted to applications by programming
software in the MD29.

Overview

The MD29 is a compact microcomputer using surface-mount components on
asingle printed circuit board. The board is designed for easy installation.

Together with the DPL Toolkit, the MD29 allows the programmer to write
software or use pre-written software in order to enhance the flexibility of a
Variable Speed Drive.

The MD29 is compatible with the following Drives:
* Mentor ll, Vector, CDE, HPCDE

The MD29AN is a special version of the MD29. It has the full functionality of
the MD29 plus a CTNet interface for Mentor Il Drives only. This interface
replaces the dedicated RS485 port for the Control Techniques I/O Box.

MD29

The term MD29 in this manual also refers to the MD29AN,
unless specified otherwise.

The terms CDE750 and CDE7500 are used in this manual.
CDE750 refers to the bookcase CDE 0.75kW to 11kW range
(1HP to 15HP); CDE7500 refers to the CDE 11kW to 90kW
range (7.5HP to 150+P), including the HPCDE.
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DPL Toolkit (Windows™ interface)

12

1-2

The DPL Toolkit is contained on two diskettes. It is a program which runs in
Microsoft® Windows™ Version 3.1x and Windows™ 95. Programs for the
MD29 are written on a host PC using the DPL Toolkit.

N

MD29

=~ Serial communications link

Host PC
(Desk-top or industrial)

The MD29 uses a high-level programming language called DPL

(Drive Programming Language) which is in many respects similar to the
BASIC language. DPL is a compiled program which gives it the ability to run
at high speed.

The DPL Toolkit is used to write, compile and download a DPL program to an
MD29. The Toolkit also has a comprehensive set of de-bugging facilities to
aid the development and testing of the DPL program.

Connection between the MD29 and host PC is via an RS232 serial
communications link. This link need only be used during program
development, testing and commissioning. It can be disconnected after the
software has been successfully loaded.

Memory

The compiled MD29 program and the user-created source program are
stored in non-volatile EEPROM memory on the MD29 card. This type of
memory allows the programs to be loaded using the serial port.

Latest versions of programs can be easily updated without removing any
integrated circuits or without using any specialized programming
equipment.

The filing system of the MD29 allows only one program to be stored in the
MD29 at any one time.

The compiled program can be stored along with the DPL source code. This
allows the site engineer to read the program stored in the MD29, even if the
program is not on the host PC. (This option can be disabled if it is not
required.)

. MD29
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1.3 PC requirements

The minimum requirement for the DPL Toolkit is as follows:
IBM AT compatible 386SX PC, Windows™ 3.1, 4Mb RAM, DOS5
A 486 PC with 8MB RAM is recommended

14 Technical data for the MD29

Intel 960 32-bit RISC processor

96kb of user program storage

8kb user RAM

16MHz clock

RS232 port for programming (IBM AT compatible)

RsS485 optically isolated port for permanent serial communications

Dedicated, optically-isolated Rs485 port for a Control Techniques
1/0 Box (not available on MD29AN)

15 User knowledge

This User Guide assumes that the user has at least superficial knowledge of
Microsoft® Windows™. Refer to the Windows User’s Guide for specific
information on performing operations in Windows™.

MD29 .
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2 Installation

severe electric shock and may be lethal. The Stop function
of the Drive does not remove dangerous voltages from the

| Warning | Drive or the driven machine.

AC supplies to the Drive must be disconnected at least
15 minutes before any cover is removed or servicing work is
performed.

2 The voltages present in the Drive are capable of inflicting a

2.1 Installation procedure

Installation procedures are given for the following Drives:
Mentor Il, CDE7500/ HPCDE, Vector

Mentor Il Drive

Location of the MD29 in the Mentor Il Drive

MD29 _
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Refer to the Mentor Il User Guide for the mechanical details.

Use the following procedure to fit the MD29 to the MDA2B circuit board of
the Drive:

1

2
3
4

Isolate the AC supply from the Drive.
Remove the front cover from the Drive.
Fit the four small securing pillars to the corners of the MD29.

Find the 40-pin header connector on the MDA2B circuit board of the
Drive.

2-2

10

The following instruction requires you to fit the vD29 to
the Drive. Correct location of the header connector is
essential.

Fit the 40-pin connector of the MD29 on to the connector on the MDA2B
circuit board, ensuring the pins are aligned, and that the pillars on the
MDAZ2B circuit board are correctly aligned with the locating holes in the
MD29.

Push the MD29 carefully into position.
Check again that the 40-pin connector is correctly plugged in.

Fit the four securing pillars on each corner of the MD29 to the Drive
circuit board.

Make any necessary serial cable connections to the MD29.
Replace the Drive cover.

MD29
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CDE7500 and HPCDE Drives

Refer to the cDE User Guide for the mechanical details.

Use the following procedure to fit the MD29 to the IN-82 control board in the
Drive, or to the IN-90 board in the HPCDE Drive:

1

2
3
4

Isolate the AC supply from the Drive.
Remove the front cover from the Drive.
Fit the four long pillars to the corner holes of the MD29.

Find the 40-pin header connector on the IN-82 control board in the
Drive.

i

— 1
Terminal Block

Location of the MD29 on the IN-82 card in the CDE7500 Drive

MD29

Issue code: 29nu4

The following instruction requires you to fit the MD29 to
the Drive. Correct location of the header connector is
essential.
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5  Fit the 40-pin connector of the MD29 on to the connector on the IN-82
control board, ensuring the pins are aligned, and that the pillars on the
IN-82 control board are correctly aligned with the locating holes in the
MD29.

6  Push the MD29 carefully into position.

7 Check again that the 40-pin connector is correctly plugged in.

8  Locate the four securing pillars on the corners of the MD29 to the IN-82
control board.
The Drive cover cannot be re-fitted directly to the case.
The cover must be raised to allow room for the MD29 card.
Use the following procedure to fit the cover.

9  Fit the four hole-stud pillars (supplied with the MD29) to the corners of
the Drive.

10  Fit the pod extension connector (supplied with the MD29) to the
D-type connector of the control pod.

11 Make any necessary serial cable connections to the MD29.

12 Fit the cover on to the pillars.

2-4

MD29
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Vector Drive

1

Location of the MD29 on the IN-31 control board in the Vector Drive

Refer to the Vector User Guide for mechanical details.

Use the following procedure to fit the MD29 to the IN-31 control board in the
Drive:

1 Isolate the AC supply from the Drive.

2 Remove the front cover from the Drive.

3 Fit the four long pillars to the corner holes of the MD29.
4

Find the 40-pin header connector on the IN-31 control board in the
Drive.

The following instruction requires you to fit the MD29 to
the Drive. Correct location of the header connector is
essential.

MD29 _
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5  Locate the 40-pin connector of the MD29 on to the connector on the
IN-31 control board, ensuring the pins are aligned, and that the pillars
on the IN-31 control board are correctly aligned with the locating holes
in the MD29.

6  Push the MD29 carefully into position.

7 Check again that the 40-pin connector is correctly plugged in.

8  Fit the four securing pillars on the corners of the MD29 to the IN-31
control board.

The Drive cover cannot be re-fitted directly to the case.
The cover must be raised to allow room for the MD29 card.
Use the following procedure to fit the cover.

9  Fit the four hole-stud pillars (supplied with the MD29) to the corners of
the Drive.

10  Fit the pod extension connector (supplied with the MD29) to the D-
type connector of the control pod.

11 Make any necessary serial cable connections to the MD29.

12 Fit the cover on to the pillars.

Bookcase CDE

It is recommended that fitting of the MD29 to bookcase Drives is carried out
by an authorized distributor since internal access to the Drive is required.

MD29
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2.2 Configuring the system

Host PC connections

RS232 Port  The Rs232 serial port is a dedicated link to the host PC. The port is a 9-way
female D-type connector. Ready-made cables for RS232 serial
communications are generally available.

The table below gives the minimum required connections between the MD29
and a 9-way and 25-way pin COM port connector.

MD29 9-pin connector | 25-pin connector
pin no. pin no. pin no.

2 2 3

3 3 2

5 5 7

The Rs232 port should be used only for commissioning because isolation or
protection of the port is not included.

Use the following instructions for connecting a host PC:

1 Ensure no static charge has built up when the plug is inserted.

2 Using amaximum cable length of not more than 3 metres (10 feet),
connect an RS232 cable to the RS232 serial port on the MD29 and to the
communications serial port of the host PC.

Installing the DPL Toolkit in the host PC

Use either of the following procedures:

Windows 3.1

The DPL Toolkit requires a minimum of 4Mb of computer memory. This may be RAM or
virtual memory. Virtual memory may be set in the 386 Enhanced section of Windows

Control Panel.

A W N P

Start Microsoft Windows
Insert disk 10of the DPL Toolkit into the A: drive of the host PC.

In Windows Program Manager, select File on the menu bar. Select Run.
Type A\SETUP.

5 Click on

MD29
Issue code: 29nu4
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Windows 95
1 Insert disk 1of the DPL Toolkit into the A: drive of the host PC.

In the i Start menu, select Run....

3 Type A\SETUP.

4 Click on

Downloading the system file

The MD29 has no pre-loaded system software. The first task is to program
the system software using the DPL Toolkit. Use the following procedure:

1 Connect the serial communications cable to the MD29.
2 Apply AC power to the Drive.

3 InWindows 3.xx Program Manager, or in the Windows 95 Start menu,
click on:

-
o

ae

L

.

The DPL Toolkit window appears. At the top of the window are a
menu bar and toolbar.

£= DPL Toolkit M=l E3

File Edit Style “iew ‘Window Favourte Project Bun Help

FREEAREEERRINEFREEREREN

4 If the serial port of the host PC is not COM1, open the Projects menu
and select Configure. In the drop-down menu that appears, select
Comport. This opens a further drop-down menu which allows
selection of the required communications port.

5  Clickon EI (Open Task Manager). After a few moments, the DPL
Task Manager dialog box appears.

DPL Task Manager [ <]
There is no system in the MD29/UD70 File Viewer

“You must program a system into the module before vou can use it

Lze File Wievser to locate a syztem program
System programs have a ' 575" extenzion
For example the Mentor Il spgtem program iz MEHTOR 2,575

. MD29
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EEEIEEREE I

& File Viewer [M2.5Y5]

File Favourte Style

If the dialog box does not appear, and all the buttons in the lower
toolbar of the window appear shaded (inactive), communications
could not be established with the MD29. Check the connecting cable is
correct, and the correct COM port is used.

File Yiewer

Click on . The File Viewer dialog box appears.

|'_sys

jl tD29+ [c] Contral Technigues

Wergion 02.00.00 Mentor

= |

= e\
= md29qui
[ bin

1 md29iss1

cdel sys
cdes.sys

mZnet_sypz
ud70net_sys
ud?Dos_sps
vect sys

4| | »

|C:hmd29guitbintaysimZ sys 3747k 22/7/36 11:03, a

In the panels on the left side of the dialog box the path and names of
the .Sys files can be selected.

7

MD29
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The system files are located in directory MD29GUI\BIN\SYS.

Select the correct path for the required system files. Double-click on
the .sYs file specified in the following table:

Drive File
Mentor Il M2.SYS
Mentor I (MD29AN) M2NET.SYS
Vector VECT.SYS
CDE (bookcase) CDES.SYS
CDE and HPCDE CDEL.SYS
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The system files for MD29 issue 1 are located in directory
MD29GUIN\BIN\SYS\MD29Is51.

2-10

The Programmer dialog box appears.

w. Programmer E3

Action

File ta praogram:

Il::\MD2SEUI'\BIN\SYS\M2.SYS

R

AR ::

[Close Progranmmer

8  Clickon % (green light showing). The system file is now loaded

into the MD29.

Installation

MD29
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Getting Started

3.1

3.2

MD29

Introduction

This chapter explains the key elements of DPL programming, and the
methods used to create, compile and run an example program using the DPL
Toolkit.

An example of a short DPL program is given below, followed by explanations
of the program instructions.

Example DPL program

The DPL program described here is called Sawtooth, because it applies a
repetitive cycle consisting of a linear increase in speed demand followed by
an instantaneous reduction to zero, as shown in the following diagram.

.
,
’
.
.
.
,
’

Repetitve cycle produced by the Sawtooth program

1000

0 ‘
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S

A

#1.18=0

Is #1.18 < 10007? Yes—p|

#1.18=#1.18+1

Flow diagram of program Sawtooth

Program instructions
$TITLE Sawtooth
$VERSION 1.1.1
$DRIVE Mentor
$AUTHOR MyName
$COMPANY MyCo
/INote: This is a comment.
BACKGROUND{
Top:
#1.18=0
DO WHILE #1.18<1000
#1.18=#1.18+1
LOOP
GOTO Top:

}

3-2 Getting Started

MD29
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Explanation of the example program

$TITLE Sawtooth
The first line of a program must be $TITLE program name. The name
can have amaximum of 64 characters.

$VERSION 1.1.1

The second line is $VERSION number. The number can have a maximum
of eight characters. The recommended format is $VERSION 1.0.0.

Updates are easily shown by increasing the last number, eg. 1.0.1.
Major modifications are shown by 2.0.0, 3.00, etc.
$DRIVE Mentor

The third line is $DRIVE drive name. This tells the compiler which Drive
it is installed in. (Since the DPL Toolkit can be used with different
types of Drive, the name of the Drive must be stated.) The list of
suffixes are as follows:

* MENTOR
« CDE750 (bookcase CDE)
* CDE7500 (large CDE and HPCDE)
« VECTOR

$AUTHOR MyName

$COMPANY MyCo

The fourth and fifth lines are used to define the author of the program
and the company name.

Unless these lines are included, the program will not be
compiled.

//Note: This is a comment.
The program ignores comment lines which can be placed anywhere in a
program. Comments are always preceded by either a double forward
slash [//] or a semi colon[;].
Comments are useful for inserting descriptions, or for giving
explanations for the benefit of the user or programmer.

BACKGROUND{

BACKGROUND is a type of Task. (All executable code must be
contained within a Task.) There are many different types of Task,
which, in effect, define the priority of the code and allow blocks of
code to be run on different time-bases.

The BACKGROUND task is a free-running task which can be compared to
the way a PLC runs a program, for example. Full details of the Tasks are
given in Real-time programming in Chapter 4 DPL Programming.

MD29 .
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Top:
Top: is a label which marks an absolute position in the program. A label
must always be followed by a colon [:].
A label defines the destination of a GOTO statement. It can be given
any name (eg. mylabel).

#1.18=0
A hash (#) expression accesses Drive parameters. In this case the
parameter is 118 (menu 1, parameter 18). This is a preset speed
reference parameter in the Mentor Drive, and it is set at zero.

DO WHILE #1.18<1000

DO WHILE is a loop statement. In this example, it gives the program an
instruction to repeat the following block of code while the value of
parameter 1.18 is less than 1000.

#1.18=#1.18+1
This line adds the value 1to parameter 1.18. Every time this command is
executed, 1is added to the parameter value.

LOOP

LOOP is the end expression for the Instruction DO WHILE. LOOP tells
the program to go back to the line DO WHILE and check that the Do
WHILE instruction remains true. When the value of #1.18 = 1000, DO
WHILE #1.18 < 1000 becomes false. The instructions between DO
WHILE and LOOP stop being repeated and the program goes to the
next line after the LOOP command.

GOTO Top:
GOTO s a flow-control instruction. In this case, it tells the program to
go to the label Top:. This causes the program to run continuously.

The label name must be specified using a colonl[:].

} Closing brace
Instructions within braces belong to the defined Task. Closing-braces
work in conjunction with opening-braces. In this example, the
opening- and closing-braces work in conjunction with the Task
BACKGROUND.

. MD29
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3.3 Creating a DPL file using
the DPL Toolkit

This section shows how to write, compile and download the example
DPL program for the Mentor Il Drive.

Opening the DPL Toolkit
In Windows 3.xx Program Manager, or Windows 95 Start menu, click on:
&
.
The DPL Toolkit window appears. At the top of the window are a menu bar
and toolbar.
£= DPL Toolkit M=l E3

File Edit Style “iew ‘Window Favourte Project Bun Help

MEEEEFEE R EEHRERREEREN R

Creating a file

1 Clickon or open the File menu and select New.
2 Enter the following program exactly as it appears, using the tab key to
indent lines.
$TITLE Sawtooth
$VERSION 1.1.1
$DRIVE mentor
$AUTHOR MyName
$COMPANY MyCo
/INote: This is a comment.
BACKGROUND{
Top:
#1.18=0
DO WHILE #1.18<1000
#1.18=#1.18+1
LOOP
GOTO Top:

}

MD29 .
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3 Open the File menu and select Save As.... The Save File As dialog box

appears.
Save File As EHE3
File name: Folders:
|sawtuuth.dp' | c:\md2?9guitprojects
Cancel |
- et -
{3 md29qui Network.__ |
3 projects
[” Read only
Save file az lype: Drives:
|DPL files (~.dpl) MERETS =]

4 Inthe Folders: list, select the Projects directory. In the File name:
text box, type SAWTOOTH.DPL.

5 Click on . The file is now saved.

The program is ready for compiling into machine code.

Important Note

DPL programs must be saved as .DPL files. If this is not
done, the program cannot be compiled into machine code.
Only the saved version of the program is compiled.

Compiling the program

The DPL Toolkit contains a compiler which converts DPL programs from text
format to binary machine code which the MD29 can understand. The
compiler converts the .DPL file into a binary file with a .BIN extension.

Use the following procedure.

=
1 Clickon £ at the right of the Toolbar. The Compile... dialog box
appears.

. MD29
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" Target Hardware:
O MD29 Issue 1
@ MD29 Issue 3, MD29AN. UD70.

" Debugging Options:
[¥ Embed Debugging Information
[¥ Embed DPL Source Code

[¥X Show Compiler Dutput Screen

1] 4 LCancel Help

2 If the DPL source file is required to be downloaded to the MD29, ensure
the Embed DPL Source Code check box is checked. This facility
allows the DPL program to be read back to the PC at alater date (if the
computer copy becomes lost, for example).

If the DPL source file is not to be downloaded, ensure the check box is
unchecked. When the Compile... dialog box next appears, the check
box retains the last setting.

(The other options in this dialog box are described in Compiling and
running programs in Chapter 5 DPL Toolkit.)

Click on

4 The Compilation box appears for a few seconds. It is not necessary to
observe the contents of the Compilation box.

5  The program is now compiled, ready for downloading to the MD29.

If instead a Build errors window appears with errors displayed, correct
the program for typing mistakes and repeat the compilation. (Error
messages are described in Chapter 9, Diagnostics.)

MD29 .
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Connecting to the MD29

It is now necessary to establish communications from the host PC to the
MD29 in order to download the compiled file.

Use the following procedure:

Click on E The Task Manager opens with the Task Manager toolbar
appearing below the standard toolbar.

#= DPL Toolkit

File Yiew Favourte Project Bun Help

=] ]

EEEEEEE R EENEREREEEEG

clJ 00000000 =i BEE

If all the buttons on the lower toolbar appear shaded, it is
an indication that communications could not be
established with the MD29. Check that AC power is applied
to the Drive, and that the serial communications cable is

correctly inserted.

Downloading the program

1 Inthe Task Manager toolbar, click on . The Programmer dialog

box appears.

w. Programmer E3

Action

File ta praogram:

Il::\MD2SEUI'\BIN\SYS\M2.SYS

g

g

R

[Close Progranmmer

3-8 Getting Started
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2 Inthe Programmer dialog box, click on E (green light showing).
The files SAWTOOTH.BIN and SAWTOOTH.DPL are now downloaded to
the MD29. Down-loading takes a few seconds to complete.

The MD29 can hold only one compiled program (ie. .BIN file)
in memory at one time. A program that is downloaded to
the MD29 will over-write an existing program.

Running the program

parameter of the Drive. For safety, ensure the Drive is

2 The Sawtooth program rapidly alters the speed reference
disabled before running the program.

In the Task Manager toolbar, click on

The Speed reference parameter #1.18 in the Drive will change value.
Note that the ramping-up behavior cannot be observed since the
program alters the parameter value at a faster rate than the display is
updated.

MD29 .
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DPL Programming

41

Program title

This chapter explains the following parts of a DPL program:
* Program headers
« Comments
« Variables
¢ Parameters
e Tasks
« User-defined sub-routines
¢ Instructions

The explanation is followed by a section on optimizing DPL programs.

Program headers

A DPL program must begin with five program headers in the correct order,
as follows:

* Program title

* Program version
* Drive name
 Author name

» Company name

Each program header must be contained on a single instruction line in
the program.

Syntax

$TITLE Program title

The $TITLE Program title is for use by the programmer.
eg. $TITLE Sawtooth generator

Maximum length: 64 characters

Program version

Syntax

MD29

$VERSION Version Number

The $VERSION Version Number is for use by the programmer. It is
recommended that the format of the version number should be as follows:

$VERSION 1.0.1

Minor updates can be shown by increasing the last digit, eg. 1.0.2. Major
modifications can be shown by increasing the first digit, eg. 2.0.0.

Maximum length: 8 characters
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Drive name

Syntax  $DRIVE Drive name

The type of Drive and its size must be specified in $DRIVE Drive name since
the DPL Toolkit can be used with different types of Drive.

This program header ensures that the program is correctly compiled for the
option module and Drive. The following is a complete list of Drive names.
$DRIVE MENTOR
$DRIVE CDE750

$DRIVE CDE7500
$DRIVE VECTOR
Note

If a different Drive is specified, the program may not be
compiled, or run-time error 53 will occur when the
program is downloaded to the mD29.

Author name

Syntax ~ $AUTHOR Author name
The $AUTHOR Author name is for use by the programmer.

Maximum length: 64 characters

Company name

Syntax ~ $COMPANY Company name
The $COMPANY Company name is for use by the programmer.

Maximum length: 64 characters

Example program headers

$TITLE Sawtooth

$VERSION 1.0.1

$DRIVE MENTOR

$AUTHOR A H.

$COMPANY Control Techniques

. MD29
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4.2

Example

4.3

Comments
Comments are purely for information and explanation purposes. They act in
the same way as REM commands by not acting on the program.

Comments begin with a double forward slash [//] or a semi-colon[;]. They
can be placed on their own line, or at the end of instruction lines. A
Comment ends at the end of the line.

/[This line contains a comment, which ends with the line.
//If the comment flows onto the next line, double forward
/Islashes must be used to start the next line.

Variables

Basic variables

Integer
variables

Floating-
point
variables

There are two basic types of variable, as follows:
« Integer variable (INT)
* Floating-point variable (FLOAT)

Integer variables are denoted by placing a % symbol after the name of the
variable, and are internally represented by a two’s complement
32-bit number. This gives a decimal range of +2147483647.

Floating-point variables have no symbol. These variables are
IEEE double-precision (64-bit) numbers which give a range of approximately
17976 x 107,

Accessing the variables

All variables are global within a program (ie. they can be accessed and
altered by any task). (There are no local variables.)

Bit-addressing of variables

Example

MD29

All integer variables and arrays (see below) may be bit-addressed. This
means that each individual binary bit in the variable may be separately read
or written to. Bit-addressing is achieved by appending .n to the end of the
variable name, where n is the bit number to be accessed.

flags%.3 =1 ;setbit3to1
IF flags%.5=1THEN...  ;check bit 5
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Naming conventions

The first character of a variable must be aletter. Subsequent characters
may include letters, numbers and the underscore (_) character. These may
be in any order.

Variable names are case sensitive (eg. the variable name speed% is not the
same as SPEED%).

Preferred use of variables

Arrays

It is recommended that integer variables are used where possible.
Operations on integer variables perform much faster than for
floating-point variables.

Dynamic
arrays

Example

4-4

Arrays are collections of variables of the same type (integer or floating
point) under the same name. Note that only single-dimension arrays
are allowed.

Each element (individual component) of an array is, in effect, a separate
variable. An element is accessed by a program by specifying the array name,
then placing the element number in square brackets [ ] after the array name

The two basic forms of arrays are as follows:

Dynamic arrays can be set up and changed by DPL programs. A dynamic
array must contain, integer variables or floating-point variables, but not
both types of variable.

A dynamic array must first be specified using the DIM instruction (usually in
the INITIAL task), and the number of elements specified in square brackets
after the variable name. Dynamic arrays are placed in the 8kB of volatile
memory in the MD29 which limits the maximum size of the array.

DIM myarray%[20] ;Integer array having 20 elements
DIM array2[30] ;Hoating-point array having 30 elements

The elements in an array are numbered as follows:
0 to [Number of elements] — 1
From the example of an integer array given above, the first element of
myarray%il] is as follows:
myarray%[0]
The last element is as follows:
myarray%i[19]

. MD29
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Constant Constant arrays contain fixed pre-defined values that cannot be changed

arrays by the DPL program when the program is being run. The values of the
constant array are defined in the DPL program by using a special section
called CONST. (This section is typed in exactly the same way as a task.)
Only integer values can be defined in a constant array.

The advantage of using a constant array is that the array is placed in the
96kB of memory space in the MD29 which allows the size of the array to be
limited only by the amount of available program space in the MD29, and not
by the size of the 8kB RAM. The program space is used to store the
compiled DPL program, constant array data, and (optionally) the

DPL file itself.

Example CONST c_array% {
100, 1500, 500, 0, —400, —1000
—400, -100, 0
}

This defines an array called c_array%[], which containes nine elements.
Note that the value of each element can be separated by acommaor a
new line.

44 Parameters

There are two types of parameter, as follows:
* Drive parameters
* Virtual parameters

(See Chapter 10 Parameters.)

Parameters are denoted by a # (hash) symbol and are accessed using an x,y
format, where x represents the menu and y represents the parameter in the
menu.

For example, parameter p7.05 is accessed by entering #07.05, and p18.01is
accessed by entering #18.01. Leading zeroes in the parameter can be
omitted, eg. #7.5is the same as #07.05.

Parameters can also be accessed indirectly using an integer variable to
denote the parameter number. See Parameter pointers later in this chapter
for details.

4.5 Operators

Operators perform mathematical or logical operations on values. The
following operators are supported in DPL programming.

Certain operators work only with integer values
or variables.

MD29 .
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Operators for floating-point and integer variables

+ Plus

- Minus

/ Divide

* Multiply

Operators for integer variables only

& Logic AND A B Y
0 0
0 1 0
1 0 0
1 1 1 Example 5&14=4
| Logic OR A B
0
0 1 1
1 0 1
1 1 1 Example 5|14=15
Logic XOR A B Y
0
0 1 1
1 0 1
1 1 0 Example 5&14=1
Value Bit invert This Operator inverts the least-significant bit, and converts all
other bits to zero.
Example 100100 (binary) is converted to 000001 (binary)
I(value, bit-field-size) This Operator inverts the specified number of least significant
Bit-field invert bits, and converts all other bits to zero. The bit-field-size
specifies the number of least-significant bits that are to be
converted.
Example Result% = (value%, 3)
100100 (binary) is converted to 000011 (binary).
% Remainder This Operator gives the remainder when an integer is divided
by another integer.
Example 5%2=1
8%3=2

4-6 DPL Programming
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4.6 Tasks and real-time programming

Real-time programming runs with reference to a clock to enable the user to
specify the actual times instructions are executed, not just the order in
which they are executed. When real-time programming, a task Structure
(or philosophy) has to be maintained.

MD29 programs contain sections called tasks, where a task enables a priority
to be given to a sub-routine. Six levels of priority are defined by these tasks
in the following order:

* INITIAL task

* BACKGROUND task
e CLOCK task

» ENCODER task

* EVENT task

* ERROR task

Each task is specified by its name in the program. The contents of each task
must be placed in braces { }.

Example CLOCK({
instructions
}
INITIAL task

The INITIAL task is used typically to initialize program variables and Drive
parameters in the DPL program. The task runs only when the MD29 is reset
or at the moment AC power is applied.

The INITIAL task has total priority over all other tasks when running; the
other tasks are prevented from running. This is significant when the CLOCK,
EVENT or ENCODER tasks are to manipulate data which have initial values.
Example INITIAL{
// This is the only place to reliably initialize ‘timer’
timer% =0

}

CLOCK({
//This task is set at 5ms
//The value of timer must be initialized before CLOCK is run
timer% = timer% + 1
IF timer% > 200 THEN
//200, 5ms intervals = 1second
PRINT “1Second expired”
timer% =0
ENDIF
}

MD29 .
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BACKGROUND task

The BACKGROUND task is used for functions and commands that do not
require time-related or encoder-related monitoring. This task would be
used for the following:

« Datalogging
* Checking digital inputs
« Setting output status
The BACKGROUND task runs after the INITIAL task is completed. It is

recommended that the majority of the program is run in the BACKGROUND
Task.

The BACKGROUND task does not automatically loop.

Example BACKGROUND{
RAMP:
#118=0
DO WHILE #1.18<1000
#1.18 = #1.18+1
LOOP
GOTO RAMP:

. MD29
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BACKGROUND Task giving way to the CLOCK Task
CLOCK Task
timing period

INITIAL
Task

CLOCK
Task

BACKGROUND
Task

2

BACKGROUND Task giving way to the CLOCK Task,
and the CLOCK Task giving way to the ENCODER Task

ENCODER Task
timing period

INITIAL
Task

ENCODER
Task

CLOCK
Task

BACKGROUND
Task

CLOCK Task
timing period

Examples of the BACKGROUND task giving way to the CLOCK and ENCODER tasks

Key to the diagram

BACKGROUND task giving way to the CLOCK task

1 The BACKGROUND task waits while the CLOCK task runs, and is then
interrupted at the next CLOCK task.

2 The BACKGROUND task continues running until next interrupted by the
CLOCK task.

3 The BACKGROUND task ends.

MD29 .
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BACKGROUND task giving way to the ENCODER and CLOCK tasks
4 ENCODER and CLOCK timing periods begin.

5  The cLock task runs until it is interrupted by the next ENCODER task.
The CLOCK task is completed when the ENCODER task has finished.

6  The cLOCK task ends, leaving time for the BACKGROUND task to run
until interrupted by the next ENCODER task.

7 When the ENCODER task has finished the next CLOCK period has not
arrived. The BACKGROUND task runs until interrupted by the next
CLOCK task.

User-defined sub-routines

User-defined sub-routines are written by the user and are used in
conjunction with the CALL instruction (see CALL in Chapter 7 Reference).

User-defined sub-routines can be given any name and can be inserted
anywhere in a program. (Note that the task name is case-sensitive.)

The following sub-routine has the same function as the Sawtooth program
given in Chapter 3 Getting Started. The name given to the sub-routine is
RAMP:.

BACKGROUND{
Loop:
CALL RAMP:
GOTO Loop:
}
RAMP: {
#1.18=0
DO WHILE #1.18<1000
#1.18=#1.18+1
LOOP

}
Important Note

Be careful not to allow a user sub-routine to be started by
two different real-time tasks (a situation termed
re-entry).

For example, a sub-routine is able to be started by a
BACKGROUND task as well as a CLoCK task. If the BACKGROUND
task starts the sub-routine, and the CLOCK task interrupts
the BACKGROUND task while the sub-routine is being
executed, the values of the variable being processed could
be altered. This can occur because the cLock task will also
run the sub-routine, but will apply its own values.

. MD29
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CLOCK task

The CLOCK task is used for time-related monitoring of the Drive, and
commands to the Drive (eg. controlled acceleration or deceleration ramp).

The task has the second lowest priority. Only the BACKGROUND task gives
way to the CLOCK task.

The task is executed on a constant timebase; the actual timebase used
depends on the value of the set-up parameter on the Drive (see also MD29
set-up parameters in Chapter 10 Parameters), which can range from ms to
200ms.
Example This example produces a sine-wave.
CLOCK({

#1.18 = SIN (rad)*1000

rad =rad+0.01

IFrad>6.283185 THEN ;6.283185=2* pi

rad=0
ENDIF

ENCODER task

The ENCODER task is primarily used to monitor the activity of an encoder.

The task is synchronized to a control loop in the Drive, so the execution
frequency of the task is determined by the Drive. A set-up parameter can
be used to multiply the time by two.

Drive Switching Timebase Timebase
frequency parameter set at O| parameter set at 1
kHz ms ms
Mentor Il Not applicable 512 2.56
CDE 3,60r12 5.52 11.04
CDE 4.50r9 7.36 14.72
Vector Any 2.008 4.016
Example ENCODER{
master_inc% = #90.2
slave_inc% = #90.4
EPOS =EPOS + master_inc% — slave_inc%
}
MD29
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EVENT task

The EVENT task runs when a specific event occurs. The source of the event
is determined by the Timer/Counter Unit.

The EVENT task has the highest priority when the program is running. All
other tasks give way to the EVENT task.

Refer to Timer/Counter Unit in Chapter 8 Features for further information.

ERROR task

The ERROR task is executed only when a run-time error has occurred in the
DPL program. If the DPL Toolkit is connected to the MD29 at the time of
the error, the error number will be displayed on the screen.
Run-time errors can be caused by a variety of occurrences. For example:
Attempting to write to aread-only parameter
A real-time task over-running
Errors are usually due to programming errors, but can sometimes occur due
to external influences. For example, an error signifying a serial
communications loss could occur if incoming data from an 1/0O Box is lost
due to the cable being broken. Normally, the MD29 halts all tasks, and
optionally trips the Drive.

If this is undesirable, the ERROR task can be used. The sequence whena
runtime error occurs is then:

1 Alltasks are stopped.

2 The Drive s tripped (if the trip is enabled). See the Trip enable
parameters in MD29 setup parameters in Chapter 10 Parameters.

The number of the error is placed in parameter #88.01of the MD29

The ERROR task is executed. The instructions in the ERROR task can
determine the cause of the run-time error and take necessary action,
such as stopping the drive system in a controlled manner.

For further information, see Advanced error-handling in
Chapter 9 Diagnostics.

NOTES task

This is a pseudo task that is ignored by the compiler. The writer of the
program uses the NOTES task to help the user of the Drive understand the
program.
Example NOTES{
You can put your documentation here.

}
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4.7 Instructions and functions

This section describes the different types of instructions which are used in
DPL programming.

Conditional instructions

A conditional instruction performs an operation according to a set condition

(eg. IF).
True @ False
(Yes)

(No)

Procedure 1 Procedure 2

Example of an IF, THEN flow diagram

Loop instructions

A loop instruction repeats a block of instructions until a specified
condition occurs.

Example DO WHILE
LOOP

Procedure 1

False
(No)

Example of a DO WHILE, LOOP flow diagram

MD29 .
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Flow-control instructions

A Flow-control instruction causes the program to jump to a specified
instruction or to be terminated (eg. GOTO).

Maths functions

A Maths function applies a mathematical operative to an expression to
return a value (eg. SIN).

Signal-processing functions

A Signal-processing function returns a value from a number of samples over
a fixed time-period.  Signal-processing functions can be used only in the
CLOCK or ENCODER tasks (eg. FILTER).

Base-conversion functions

A Base-conversion function acts upon a value to convert Binary Coded
Decimal to Binary and vice versa. Base-conversion functions are useful for
datareceived from an 10 Box. Refer to Chapter 6 Serial Communications.

Data-conversion functions

A Data-conversion function converts a floating-point variable to an integer
variable and vice versa.

ANS| instructions

An ANSl instructions allows a DPL program to communicate via the RS485
port with other Drives and MD29 cards using the ANSI protocol. Refer to
Chapter 6 Serial Communications.
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4.8 Optimizing programs

In order for programs to run effectively, the following are recommended.

Integer variables

Use integer variables where possible, rather than floating-point variables.
The processing of a floating-point variable is 20 times slower than for an
integer variable. (See INTinstruction in Chapter 7 Reference.)

Fixed-point arithmetic

To represent decimal places, use fixed-point arithmetic. For example, if a
resolution of .001is required, let 1be represented by 1000. This allows
accuracy to be maintained throughout mathematical operations.

The output from an expression must then be corrected by arelevant

dividing factor.
Example a% =1500 /! “a% =1.5"
b% = 2500 /! “b% =2.5"

% =a% * b% /1 % = 3750000

// Divide by 1000 to adjust c%

c% = c%/1000 /! “c% =3.750"

// To convert to the real value, we must divide by 1000 again
#1.21=c%/1000 // “c% =3.75"

Temporary integer variables

Minimize the number of times parameters are accessed. Instead of
accessing a parameter repeatedly, use temporary integer variables if a
parameter value is needed more than once. The access time for a
parameter is 50 times greater than that for a variable.

Example IF #1.18 > 100 THEN

range% =1

ELSEIF #1.18 > 200 THEN
range% = 2

ENDIF

This becomes:

temp% = #1.18

IF temp% > 100 THEN
range% =1

ELSEIF temp% > 200 THEN
range% = 2

ENDIF

MD29 .
Issue code: 29nu4 DPL Programmlng 4-15




Integer division

When using integer division, accuracy may be lost in the result, as shown in
the following expression:

If#1.18 isequalto 5

Then we have the following:

a=45* (#1.18/4)

=45*(5/4)

=45*1

=45
The DPL compiler uses an integer divide, converts the result to a
floating-point value and uses a floating-point multiply.
To preserve accuracy, one of the arguments can be converted to a
floating-point variable, as follows:

a=45* (#1.18/ FLOAT(4))

=4.5*(5/ FLOAT(4))

=45*1.25

=5.625

See FLOAT instruction in Chapter 7 Reference.

PRINT instruction

Do not over-use the PRINT instruction. (See PRINT instruction in Chapter 7
Reference). It is preferable to use the Watch window in the DPL Toolkit to
monitor variables (see Chapter 5 DPL Toolkit).

Use the PRINT instruction only in the BACKGROUND task. If the PRINT
instruction is included in the CLOCK or ENCODER tasks, the PRINT instruction
may have insufficient time to be executed. Text waiting for printing may
not then be printed.

BACKGROUND task

Place as much of the program as possible in the BACKGROUND task rather
than in the CLOCK, ENCODER or other real-time tasks. Since the real-time
tasks are on a fixed timebase, the processing must be completed in this
time. The BACKGROUND task does not have this restriction.
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#INT instruction

The #INT instruction converts a parameter that requires floating-point
variables to accept integer variables. This greatly increases processing
speed.

Example #2.00=21
// set #2.00 at 2.1 on CDE750 Drive
//is the same as
#INT2.00 =21
// Reading is also possible:
value% = #INT2.00

4.9 Parameter pointers
A parameter pointer is an integer variable that represents a Drive parameter.

Example A% =T18 // set A% to point to #1.18
#A% =10//write 10 to the pr A% points to (#1.18)

If the parameter contains a decimal-point, the decimal
point is ignored. (For example, parameter 2.00 in the
CDE Drive is in units of 0.1. A value of 2.3 must be
written as 23.)

MD29 .
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4.10 Defining aliases (constants)
Sometimes it is useful to assign a meaningful name to a parameter or a value.
For example:
Parameter #1.18 could be referred to as SPEED_REFERENCE
Instructions can be written in the form:
SPEED_REFERENCE = MAX_SPEED
Aliases are created using the $DEFINE directive. The syntax is:
$DEFINE name value.
The $DEFINE directive can be used to assign the required value to aname
that is used subsequently in the program; the name becomes an alias for the
value. All occurrences of the name are replaced by the value when the
program is compiled.
Comments are not allowed at the end of a $DEFINE line.
There are two parts to an alias, as follows:
Name The name parameter specifies the name to be defined. This
parameter can be any combination of letters, digits and underscore
characters. Spaces are not permissible.
Value The value parameter can be used to specify any constant
parameter value or parameter number.

Example  This example (for the Mentor Il Drive) demonstrates use of the $DEFINE
directive to assign names to parameter numbers (#3.02 and #1.18) and to a
value (500).

$define MAX_SPEED 500

$define SPEED #3.02

$define SPEED_DEMAND #1.18

BACKGROUND{

top:

IF SPEED < MAX_SPEED THEN

SPEED_DEMAND = SPEED_DEMAND + 1

ENDIF

GOTO top:

}

. MD29
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5 DPL Toolkit

This chapter describes operation of the DPL Toolkit, compiling of programs,
and the debugging facilities.

5.1 Overview of the DPL Toolkit

The DPL Toolkit enables the user of the MD29 to amend, write and download
programs to the MD29. The Toolkit consists of a set of compilation tools
and a comprehensive editor and debugger.

Save File — Find/Replace
Lpad File = Bookmarks  Cut Copy Paste DOS Prompt - Ordine Help
Open File —
File Wiewer — ’7 Fomple
" Task Manager
Mew File —| |—

SEEEIFIRE R RNRENEERREREER

Main toolbar of the DPL Toolkit

The compilation tools enable the user to perform the following:
+ Develop and edit real-time programs for the MD29.
+ Cut and copy program text to the Windows clipboard.
+ Paste program text from the Windows clipboard.
+ Load an existing program from the MD29.
+ Compile the program into machine code.
The debug facility has the following tools:

* Read the values of the Drive parameters on the screen and edit the
values while the DPL program is running.

+ Read the values of the Variable parameters on the screen and edit
the values while the DPL program is running.

+ Single-step mode for program checking.
* Breakpoints.

Only one program can be stored in the MD29 at any
one time.

MD29
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5.2

File menu

File management

File management in the DPL Toolkit follows similar principles to that in other
Windows applications. In addition to the standard procedures, there are
procedures specific to the DPL Toolkit. These are given below.

Creating a
new file

Opening an
existing file

Re-loading
the last-
saved file

Saving a file

The File menu is as follows:

New Ctrl+N

Open... Ctrl+0
Load...

Beload

Save Ctrl+5
Save As...

Close

Yiew Current File Ctrl+l
View Last File

Print...
Printer Setup...
Printer Font...

Add to »
Remove from »
Use As »

Exit

In the File menu, select New, or click on . A blank page is created for
you to start work on.

There are two methods of opening a file,as follows:
Load into a new Window

In the File menu, select Open..., or click on
Load into the existing window replacing the current contents

In the File menu, select Load..., or click on

In the File menu, select Reload.

In the File menu, select Save As..., or click on
DPL files must be saved with a .DPL filename extension before they can be
compiled.
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Add a
filename to a
menu

File Viewer

The Add to option allows files to be added to amenu for easy access.
When the Add to option is selected, the following list appears.

Add to Favourite

Add to Cue Cards
This list refers to two of the main menu items Favourite and Cue Cards in
the Toolkit. When one of these menus is selected, files which are added to

the menu are listed in a drop-down menu. The file can then be immediately
selected.

The options are as follows:
Add to favourite
This adds the open file to the Favourite menu.
Add to Cue Cards
This adds the open file to the Cue cards under the Help menu.

MD29

Copy  Append

Inzert File — Frogrammer
Load File — |7 Expand/Collapze Wiewer

Open File -| |— Exit Wiewwer

=ile Viewer [NEYWDPL.DPL]
File |Eavqurite

Shylle
S 8] DA [ [

= dnl $Title untitled
ID—I E $W'erzion 0.0.1
|E|CI [M5SDOS...] |£I $Drive Mentor
=y iritial §

[= md29gui }
background §
1
clock {

[rewdoldpl ||}

errnder {
« -

HE

|C:Amd23guibin'newdpl.dpl 123 butes 27./9/94 18:08, a
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Opening
File Viewer

Copying and
pasting text

Copying and
pasting
sub-routines

5-4

File Viewer allows the user to perform the following:
+ View a file without opening it
+ Copy text from an unopened file and paste it in the open file
* Pre-select individual lines for copying in one operation

Do either of the following:

Click on (File Viewer).

In the File menu, select View Current File or View Last File.
When View Current File is selected, File Viewer appears with the
currently open file loaded.

When View last file is selected, File Viewer appears with the last-saved file
loaded. This file is not necessarily the file that is displayed on the screen.

1 Select the file and highlight the text that you want to copy.

Click on ( Copy).

Place the cursor in the required position for the selected text.
4 Open the Edit menu and select Paste in the drop-down menu.

Use either of the following procedures to select a sub-routine and paste it
into different programs.

Using File Viewer
1 Save the sub-routine as afile. See Chapter 4 DPL Programming.
2 Place the cursor in the open program where the text is to be inserted.

3 OpenFile Viewer. In the box at the bottom left corner of File Viewer is
alist of saved files.

4 Select the name of the file that contains the required sub-routine.

=)
5 Clickon . (Viewer Insert).

Using the main toolbar

1 Save the sub-routine as afile. See Chapter 4 DPL Programming.

2 Place the cursor in the open program where the text is to be inserted.
3 Open the Edit menu and select Insert File in the drop-down menu.
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5.3 Editing a program

Edit menu
The Edit menu is as follows:
Undo Alt+Bksp
Cut Crl+x
Cut Line Ctrl+D
Copy Ctrl+C
Paste Ctrl+¥
Append Ctrl+K
Clear
Find { Replace Ctrl+F
Go To Line...
Go To Next Bookmark Ctrl+G
Toggle BookMark Ctrl+M
Clear All Bookmarks
Toggle Case
Insert File...
Insert TimelDate
Select All
The basic editing tools are similar to other Windows applications. The tools
allow you to cut, copy, paste, clear and undo.
Cutting a Select Cut Line to delete highlighted instruction lines.
line
Findingand  Select Find/Replace to find and replace characters and words. The Find
replacing dialog box appears.
text

|gntn top] | E | Mext |
| | EI | fepacs |

[ flave Bepsiive | T¥BSD A

[ bl Wod 5
[ wiea at onds _m

Use this option in the same way as the Find/Replace option in Windows word
processors.
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Appending Use the following procedure to copy lines in a specific order from
instruction File Viewer to the program being written:
lines 1 Select in turn the lines shown in File Viewer that are to be copied to
the new program.
2 After each selection, click on (Append).
3 Place the cursor in the required position for the lines to appear in the
new program.
4 Open the Edit menu and select Paste in the drop-down menu.
BookMarks
BookMarks are useful for negotiating long programs. A BookMark is
inserted into a program where the writer needs to refer to alocation on a
regular basis. A number of BookMarks may be used in a single program.
Setting a 1 Position the cursor in the program where the BookMark is to be
BookMark placed.
2 Clickon (BookMark).
Returning to g
aBookMark 1  Clickon (Next BookMark).
2 The cursor goes to the BookMark that has been placed. If the
Next BookMark button is clicked on again, the cursor highlights the
next BookMark. BookMarks are highlighted in the order they were
placed.
Clearing Open the Edit menu, and select Clear All BookMarks.
BookMarks
. MD29
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5.4

Styles

Applying styles

The Style menu is as follows:

+ Style 1 [Normal] Shift+F1

Style 2 Shift+F2
Style 3 Shift+F3
Font...

Text Colour...

Background Colour...
+ Autolndent
Tab stops 3

Save Settings As ... »

Auto-indent

Styles let you alter the way the DPL Toolkit screen appears. There are 48
background and text colours giving over 2000 combinations of colours that
can be used.

Under Font, there is an extensive list of text fonts including TrueType fonts.

MD29

Autolndent allows you to set a tab for DO WHILE...LOOP and IF...ENDIF
commands. When the Enter key is pressed at the end of the line the indent
is automatically retained for the next line. To delete the indent, press the
Backspace key.

Using this method of indents, you can easily pick out discrepancies in the
programming by ensuring that an IF statement ends with an ENDIF
statement and that a DO statement ends with a LOOP statement (see
Chapter 7 Reference).
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55 Compiling and running a program

Task Manager toolbar

The DPL Task Manager contains powerful compilation and debugging tools.
These tools enable the programmer to check the program in great detail.
Some of the debugging tools are automatic and check for programming
errors. Others allow the programmer to check the program line by line to
verify the logic of the program.

Restart Pause Task Buttons wiatch Window
Set Breakpaint Log Wwindow

Find Breakpaint E_ackground Encoder Event Systern Info
Compile & Fragram Iritial | Clock Errar Fird DPL File
Program—| ‘ ’7 |— Upload

@G @00 X =< el

Compiling a program

1 Save the written program as a.DPL file.

=
2 Clickon £ (Compile), or to compile and download the program
automatically, click on:

The Compile... dialog box appears.

" Target Hardware:
O MD29 Issue 1
@ MD29 Issue 3, MD29AN. UD70.

" Debugging Options:
[¥ Embed Debugging Information
[¥ Embed DPL Source Code

[¥X Show Compiler Dutput Screen

1] 4 LCancel Help

If the MD29 in use is hardware issue 1, check the MD29 Issue 1radio button.

Normally the options can be left as they are shown. In this case, to continue
the compilation process click on:

MD29
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